
	

https://zagegufipazat.nurepikis.com/374166557848881691329389254418802403881199?dekotazewokofulunukizejininovojerimuzodamajowawub=reralapoziloxisatuturavoguxelaginetisenatunubakowiromubopujekotupuvesivunotobotepasuvapegubinomojovuxevofosodutasukusimadaxinomuledelorufilidulapofevuzegomusevatumuzedilujajimazopexosorexitalaxireduwu&utm_term=convert+pdf+in+google+docs&kitigizugimawogukoxisexugisikekazasefitagone=puranafixivagubinusedafivifivaxetoxazakagavefadewufunigaxegeritexiwagafawomibivatibotovolijaputibobadufunesorilapodevizones






























We	recommend	that	first	you	use	the	free	PDF	to	Word	converter.	Keep	reading	to	find	out	why...Are	you	looking	for	an	efficient	and	easy	way	to	convert	your	PDFs	to	Google	Docs?	In	this	blog,	we	walk	you	through	the	steps	to	convert	PDF	files	to	editable	Google	Docs	files.	Whether	you're	a	student,	professional,	or	simply	someone	who	wants	to
make	the	switch,	this	guide	is	designed	to	help	you	with	guides	and	free	conversion	tools.This	post	will	show	you	how	to:Turn	a	PDF	into	a	Google	Doc.Insert	a	PDF	into	a	Google	Doc	as	an	image.Add	a	PDF	to	your	document	as	a	link.Wondering	how	to	convert	a	PDF	to	Google	Docs?	Here	are	the	simple	steps	and	tools	to	help	you	turn	your	original
file	into	an	editable	Docs	file.Opening	a	PDF	directly	inside	of	Google	Docs	is	useful	if	you	are	trying	to	extract	and	edit	the	text	and	you	aren’t	worried	about	the	formatting.	Your	Doc	will	contain	the	content	of	the	PDF,	but	it	will	be	unorganized	and	images	are	unlikely	to	format	as	you	want	them	to.Go	to	your	Google	Drive	>	New	>	File
Upload.	When	the	PDF	has	uploaded	to	your	Drive,	right	click	and	select	Open	with	>	Google	Docs.Need	to	convert	PDF	to	Google	Docs	without	losing	formatting?	Convert	the	PDF	to	a	Word	document	before	opening	in	Docs.	We	recommend	using	this	method	to	convert	your	files	in	a	way	that	keeps	as	much	original	formatting	as	possible.	With
iLovePDF,	you	can	choose	between	normal	conversion	or	OCR.	Without	OCR	the	tool	is	extremely	accurate,	but	if	you	wanted	even	more	accuracy	then	convert	using	OCR.	This	will	scan	the	document	and	its	images	to	create	editable	text	from	the	original	content.Upload	your	file	to	the	free	PDF	to	Word	converter.Choose	between	normal	conversion
or	OCR	and	click	Convert	to	Word	to	download	your	converted	Word	file.Go	to	your	Google	Drive	>	New	>	File	Upload	and	upload	your	Word	file.When	the	file	has	uploaded	to	your	Google	Drive,	right	click	and	select	Open	with	>	Google	Docs.Are	you	trying	to	put	a	PDF	into	Google	Docs	instead	of	converting?	If	you	have	important	information	that
you	want	to	share	inside	of	your	Doc,	use	this	method	to	include	PDF	pages	as	images.		Go	to	the	PDF	to	JPG	tool.Upload	the	PDF	from	your	computer,	Google	Drive,	or	Dropbox.Select	Page	to	JPG	to	extract	every	page	of	the	PDF	or	Extract	Images	to	convert	all	images	embedded	in	the	PDF	into	JPG.Click	Convert	to	JPG.Click	Download	JPG	images	to
save	the	files	to	your	local	storage,	upload	them	to	the	cloud	platforms,	or	download	using	a	QR	code	and	link.Open	your	Google	Doc	and	go	to	Insert	>	Image	>	Upload	from	computer.Find	the	JPG	files	you	just	downloaded.Highlight	the	files	you	want	to	add	to	your	Google	Doc	and	select	Open.You	can	also	upload	a	PDF	to	your	Google	Doc	using
Google	Drive.	This	is	a	great	way	to	insert	and	share	the	information	contained	in	PDFs	without	visually	adding	the	pages	to	your	Google	Doc.Imagine	you	have	an	internal	business	document	with	a	large	number	of	PDFs.	Using	this	link-sharing	method	you	can	easily	provide	access	to	Docs	without	having	to	include	hundreds	of	PDF	pages.	Upload	or
save	the	PDF	to	Google	Drive	if	you	haven’t	already.	Find	the	PDF	you	want	to	share	inside	your	Google	Drive.Right-click	the	file	and	select	Get	link.Choose	the	Share	settings	to	decide	who	has	access	to	the	file.	Click	Copy	link.Open	the	Google	Doc	that	requires	the	PDF	link.Paste	the	link	inside	of	your	Doc.Clicking	the	hyperlink	will	open	up	the
PDF	in	a	separate	window.	We	hope	this	guide	has	shown	you	how	easy	it	is	to	convert	and	share	your	documents	between	PDF	and	Google	Docs.	Do	you	work	with	a	lot	of	PDFs?	If	you’re	looking	for	more	PDF	converters	then	iLovePDF	has	the	tools	for	you.	Our	goal	is	to	save	you	time	by	making	your	document	management	as	simple	as
possible.That’s	why	we	offer	several	free	online	PDF	converters	for	Office	and	image	files.	Need	to	convert	a	PDF	to	Word	instead	of	using	Google	Docs?	Use	our	free	PDF	to	Word	tool	for	an	editable	final	document.We	also	offer:PDF	to	Word	/	Word	to	PDF	PDF	to	PowerPoint	/	PowerPoint	to	PDF	PDF	to	Excel	/	Excel	to	PDF	PDF	to	Image	/	Image	to
PDFGo	to	iLovePDF	iLovePDF	takes	security	very	seriously.	Remember	that...	No	matter	which	tool	you	are	using,	we	use	end-to-end	encryption	to	ensure	the	highest	protection	against	theft	or	interception	of	your	documents.	Any	document	uploaded	to	our	system	is	automatically	deleted	after	2	hours	to	prevent	any	unauthorized	third-party	access.
All	our	servers	are	secured	under	European	legislation,	one	of	the	most	restrictive	in	the	world.	Open	Google	Drive	Click	on	Upload	>	Upload	the	PDFLocate	the	PDF	>	Perform	a	Right-click	Select	"Open	With"	>	Google	DocsGo	to	File	Menu	in	Google	Docs	>	Download	as	Google	DocsLooking	to	convert	a	PDF	into	an	accessible	Google	Doc?
Converting	a	PDF	to	a	Google	Doc	is	a	quick	and	effective	way	to	edit,	collaborate,	or	repurpose	content	directly	within	Google	Docs.	Whether	you	need	to	update	a	document,	extract	text,	or	share	it	for	real-time	collaboration,	Google	Docs	offers	a	seamless	way	to	import	and	convert	PDFs.	This	article	will	walk	you	through	how	to	convert	a	PDF	to
Google	Doc,	ensuring	that	your	document	keeps	its	content	and	formatting	as	accurate	as	possible.	With	this	feature,	you	can	save	time	and	effort	while	transforming	static	PDFs	into	editable	Google	Docs.How	to	Convert	a	PDF	to	Google	DocWhy	convert	a	PDF	to	a	Google	Doc	Converting	a	PDF	to	a	Google	Doc	is	essential	when	you	want	to:Easily
edit	PDF	content	without	using	specialized	softwareCollaborate	in	real-time.Extract	and	reformat	information.Access	files	across	devices.Use	advanced	Google	Docs	tools.How	to	Save	a	PDF	in	Google	Docs	(2	Methods)	Converting	a	PDF	file	to	a	Google	Doc	is	a	very	simple	task	which	requires	minimum	efforts.	If	you	need	to	know	how	to	save	a	pdf	as
a	google	doc	file	then	you	can	follow	the	following	mentioned	steps	and	you	will	be	able	to	save	pdf	in	google	docs.There	are	mainly	two	ways	in	which	you	can	explore	how	to	turn	pdf	into	Google	Docs	and	we	will	be	covering	both	the	ways	below:	Method	1:	Convert	PDF	to	Google	Docs	with	FormattingFollow	the	below	steps	on	how	to	make	a	PDF	to
a	Google	Doc	with	Formatting:	Go	to	the	Google	Drive	and	login	in	with	your	credentials.Step	2:	Select	My	DriveClick	on	the	New	Button	just	below	the	Drive	icon	on	the	left	hand	side	of	screen.	If	the	file	is	already	available	in	your	google	drive	account	then	you	can	jump	to	Step	5	directly.	Uploading	the	FileStep	3:	Selecting	the	FileNow	after
clicking	on	the	New	button	a	drop-down	menu	will	appear	on	the	screen	which	will	consist	of	upload	file	option,	creating	a	new	folder	and	list	of	other	cloud	platforms	.	Now	as	we	need	to	upload	the	PDF	file	of	our	choice	so	we	need	to	select	the	File	upload	option.Selecting	the	FileStep	4:	Upload	the	PDF	FileAfter	you	have	selected	File	Upload
option	then	you	will	be	directed	to	your	system's	file	manager	where	you	have	to	choose	the	PDF	file	you	want	to	convert.	After	selecting	the	PDF	file	click	on	Open	Button	to	upload	the	file.	As	an	example	here	is	a	sample	PDF	file	uploading	for	your	reference.	File	UploadedStep	5:	Opening	PDF	with	Google	DocsRight	click	on	the	uploaded	file	and
then	select	Open	With	option	and	then	select	Google	Docs.	The	file	will	now	open	in	the	Google	Docs	where	you	can	work	on	your	file.Opening	with	Google	DocsStep	6:	Editing	the	Uploaded	FileNow	a	Google	document	will	be	created	with	the	content	of	the	PDF	you	have	just	uploaded.	You	can	now	work	on	this	file	by	making	use	of	tools	and	services
provided	by	the	Google	Docs	and	create	a	well	formatted	document	by	showing	your	level	of	creativity.Editing	the	Uploaded	FileStep	7:	Saving	the	FileGo	to	the	File	option	and	Select	Make	a	Copy	button	to	save	the	file.Saving	the	FileMethod	2:	Convert	your	PDF	to	a	Google	Docs	without	formattingFollow	the	steps	below	to	know	how	to	make	a	pdf
a	Google	Doc	without	Formatting:	Step	1:	Open	Google	DriveVisit	the	Google	Drive	Official	Website	by	any	of	your	web	browsers.Open	Google	DriveStep	2:	Upload	PDF	and	Open	With	Google	DocNow	upload	the	PDF	to	the	Google	Drive	and	then	simply	by	selecting	"Open	With"	>	"Google	Docs"	open	the	PDf	into	Google	Docs.Upload	PDF	to	Google
DocStep	3:	Remove	Formatting	Now	go	to	the	Format	menu	and	select	"Remove	Formatting"	to	remove	all	the	formatting	of	the	document.Remove	Formatting	Step	4:	Download	the	DocumentTo	download	the	PDF	go	to	the	File	menu	and	select	"Download"	button	to	specify	the	format.	Download	the	DocumentHow	to	Open	PDF	in	Google	Docs	as	a
JPG	(Alternate	Method)If	you	have	crucial	information	to	share	in	your	document,	consider	this	approach	to	convert	PDF	pages	as	images.	After	learning	how	to	convert	pdf	into	google	doc,	this	method	allows	you	to	effectively	present	essential	content	visually	within	your	Google	Doc.	Follow	the	below	steps	know	how	to	convert	your	PDF	to	Google
Docs	as	a	image:Step	1:	Go	to	the	PDF	to	JPG	Tool	Pick	any	of	your	tool	to	convert	PDF	file	into	JPG.Go	to	the	ToolStep	2:	Upload	PDF	Document	from	your	computerClick	on	the	Upload	button	and	upload	any	of	your	PDF	file	to	the	tool.Step	3:	Select	Pages	you	need	to	convert	into	JPGChoose	"Page	to	JPG"	to	convert	each	page	of	the	PDF	into	a
separate	JPG	image,	or	opt	for	"Extract	Images"	to	convert	all	images	embedded	within	the	PDF	into	JPG	format.Page	to	JPGStep	4:	Click	Convert	to	JPGPress	the	"Convert"	button	to	convert	the	PDF	to	JPG.Step	5:	Download	JPG	images	Now	download	the	images	by	clicking	on	the	"Download"	button.Click	on	Download	Images	Step	6:	Open	Google
Docs	Navigate	to	the	Google	Docs	from	any	of	your	web	browsers.Step	7:	Go	to	Insert,	Click	on	Image	and	Select	Upload	from	ComputerUpload	the	image	to	the	Google	Docs	by	going	to	the	Insert	menu.	Image	Inserted	You	can	upload	a	PDF	to	your	Google	Doc	through	Google	Drive.	This	method	allows	you	to	share	the	information	in	the	PDFs
without	actually	inserting	the	pages	into	your	document.	To	add	a	PDF	link	to	your	Google	Doc:Step	1:	Upload	PDF	to	Google	DriveIf	you	haven’t	done	so	yet,	upload	the	PDF	file	to	your	Google	Drive.Insert	a	PDFStep	2:	Locate	the	PDF	and	Copy	the	LinkFind	the	PDF	file	you	wish	to	share	within	your	Google	Drive.	Performa	right	click	on	the	PDf	and
select	the	"Share"	button	and	then	click	on	the	"Copy	Link"	to	copy	the	link.Click	on	Share>>Copy	Link	Step	3:	Paste	in	Google	DocOpen	the	Google	Doc	where	you	want	to	add	the	link	and	paste	it	in.	Now,	clicking	the	hyperlink	will	open	the	PDF	in	a	new	window.Paste	the	Link	Conclusion	Converting	a	PDF	into	a	Google	Doc	is	simple	and	highly
efficient,	whether	you're	on	a	Mac,	iPad,	iPhone,	Chromebook,	or	any	other	device.	By	uploading	your	PDF	to	Google	Drive	and	using	the	Open	with	Google	Docs	option,	you	can	seamlessly	edit	and	manage	your	document.	For	those	wondering,	how	do	you	convert	a	PDF	to	a	Google	Doc,	the	steps	are	straightforward	and	allow	you	to	maintain
flexibility	across	devices.	With	these	methods,	you	can	easily	transition	between	formats	and	work	collaboratively,	all	while	leveraging	Google	Docs'	powerful	editing	tools.	You	can	quickly	convert	PDF	to	Google	Docs	in	Google	Drive	or	use	Xodo's	online	converter	for	accurate	conversion	while	preserving	the	original	formatting.	Looking	to	convert
PDFs	to	Google	Docs?	Whether	you're	a	student	revising	an	assignment,	a	professional	updating	a	contract,	or	simply	editing	a	PDF,	mastering	this	skill	is	essential.Converting	your	locked-down	PDFs	into	editable	Google	Docs	enables	seamless	editing,	sharing,	and	collaboration	online.In	this	guide,	we'll	walk	you	through	the	process	of	converting
PDFs	to	Google	Docs,	offering	useful	tips	for	editing,	troubleshooting,	and	sharing	your	documents	effortlessly.Follow	these	steps	to	quickly	convert	your	PDF	into	Google	Docs	directly	in	Google	Drive:	Upload	the	PDF	file	to	your	Google	Drive.Once	the	file	is	uploaded,	right-click	on	it.Select	Open	with	>	Google	Docs.The	platform	will	automatically
turn	your	PDF	file	into	an	editable	Google	Doc.This	method	is	effective	for	converting	PDFs	containing	simple	text,	but	it	may	prove	less	accurate	with	complex	formatting,	images,	or	non-standard	fonts.Be	sure	to	review	your	document	for	any	issues	post-conversion	as	some	formatting	may	need	to	be	adjusted.Here's	how	to	convert	PDF	to	Google
Docs	while	preserving	original	formatting	with	Xodo:	Open	your	PDF	in	Xodo’s	free	online	PDF	to	Word	converter.Click	on	Convert	to	start	the	conversion	process.Save	your	converted	Word	file	to	your	Google	Drive.	You	can	then	directly	open	your	document	using	Google	Docs.Use	the	above	method	for	accurate	conversion	of	PDF	files	featuring
complex	structures	or	layouts	to	ensure	no	original	formatting	is	lost.We	all	know	that	conversions	won’t	always	go	right	the	first	time	around.	Here	are	some	quick	troubleshooting	tips	to	overcome	obstacles	when	converting	your	PDF	into	Google	Docs.You	may	face	issues	when	uploading	your	PDF	files	to	Google	Drive.	This	can	be	due	to	a	slow
internet	connection	or	a	file	that's	too	large.Try	refreshing	the	page	to	solve	the	issue	or	split	your	PDF	into	smaller	files.	Another	issue	may	involve	opening	PDFs	directly	in	Google	Docs.	This	can	be	due	to	incompatible	files	or	browser	issues.	For	this	issue,	try	logging	into	Google	Docs	in	a	different	browser	or	updating	your	browser	to	the	latest
version.Got	formatting	discrepancies	after	converting	PDF	to	Google	Docs?	This	might	be	due	to	the	nature	of	the	file	or	intricate	layout	and	structure	of	the	PDF.	Simplifying	and	editing	your	PDF	layout	can	help	maintain	the	formatting	accurately.In	some	cases,	data	might	be	missing	after	the	PDF	to	Google	Docs	conversion.This	can	happen	if	the
data	was	in	an	unusual	font	or	format	that	Google	Docs	can't	process.	In	such	cases,	converting	the	data	to	a	standard	format	before	conversion	might	help.	Follow	the	steps	in	the	second	conversion	method	we	covered	above.Sometimes,	Google	Docs	fails	to	convert	the	file	altogether.	This	could	be	because	the	file	is	password	protected,	encrypted,
or	in	a	format	incompatible	with	Google	Docs.	Ensuring	the	PDF	is	unprotected	and	in	a	compatible	format	will	allow	for	a	smooth	conversion.Now	that	your	PDF	content	is	converted	to	Google	Docs	format,	it	becomes	editable,	allowing	you	to	use	the	platform	to	make	changes	to	your	PDF	content.Follow	these	simple	steps	to	edit	your	PDF	content
using	Google	Docs:	Open	the	PDF	file	in	Google	Docs.	Use	the	available	tools	to	edit	your	document.	Add,	delete,	or	modify	the	text	or	images,	change	the	font	style,	size,	and	color,	apply	formatting	styles	like	bold,	italics,	underline.You	can	also	insert	tables,	hyperlinks,	comments,	special	characters	and	many	other	elements,	letting	you	edit	PDF
content	using	Google	Docs.	Google	Docs	also	makes	sharing	and	collaborating	on	PDF	files	easy.	After	converting	your	PDF	to	Google	Docs,	click	the	"Share"	button,	located	in	the	upper	right	corner	of	the	document.	You	can	then	invite	others	to	view,	comment	on,	or	edit	the	document	by	entering	their	email	addresses.After	you've	finished	editing
the	converted	PDF	file,	you	can	save	it	as	a	Google	Docs	file.	If	you	wish	to	keep	it	in	Google	Docs,	simply	close	the	document,	and	it	will	automatically	save	to	your	Google	Drive.Knowing	how	to	convert	PDF	to	Google	Docs	is	an	easy	way	to	integrate	your	existing	document	workflows	with	Xodo.	You	can	install	the	free	Xodo	app	from	the	Google
Marketplace	to	work	faster	and	easier	with	PDF	documents	inside	your	Google	Drive.	Xodo	can	also	help	step	in	when	you	need	to	convert	your	Google	Docs	to	PDF	again.	Explore	over	30	PDF	tools	offered	by	Xodo	to	enhance	your	document	management	across	web,	desktop,	and	mobile	platforms.	We	recommend	that	first	you	use	the	free	PDF	to
Word	converter.	Keep	reading	to	find	out	why...Are	you	looking	for	an	efficient	and	easy	way	to	convert	your	PDFs	to	Google	Docs?	In	this	blog,	we	walk	you	through	the	steps	to	convert	PDF	files	to	editable	Google	Docs	files.	Whether	you're	a	student,	professional,	or	simply	someone	who	wants	to	make	the	switch,	this	guide	is	designed	to	help	you
with	guides	and	free	conversion	tools.This	post	will	show	you	how	to:Turn	a	PDF	into	a	Google	Doc.Insert	a	PDF	into	a	Google	Doc	as	an	image.Add	a	PDF	to	your	document	as	a	link.Wondering	how	to	convert	a	PDF	to	Google	Docs?	Here	are	the	simple	steps	and	tools	to	help	you	turn	your	original	file	into	an	editable	Docs	file.Opening	a	PDF	directly
inside	of	Google	Docs	is	useful	if	you	are	trying	to	extract	and	edit	the	text	and	you	aren’t	worried	about	the	formatting.	Your	Doc	will	contain	the	content	of	the	PDF,	but	it	will	be	unorganized	and	images	are	unlikely	to	format	as	you	want	them	to.Go	to	your	Google	Drive	>	New	>	File	Upload.	When	the	PDF	has	uploaded	to	your	Drive,	right	click
and	select	Open	with	>	Google	Docs.Need	to	convert	PDF	to	Google	Docs	without	losing	formatting?	Convert	the	PDF	to	a	Word	document	before	opening	in	Docs.	We	recommend	using	this	method	to	convert	your	files	in	a	way	that	keeps	as	much	original	formatting	as	possible.	With	iLovePDF,	you	can	choose	between	normal	conversion	or	OCR.
Without	OCR	the	tool	is	extremely	accurate,	but	if	you	wanted	even	more	accuracy	then	convert	using	OCR.	This	will	scan	the	document	and	its	images	to	create	editable	text	from	the	original	content.Upload	your	file	to	the	free	PDF	to	Word	converter.Choose	between	normal	conversion	or	OCR	and	click	Convert	to	Word	to	download	your	converted
Word	file.Go	to	your	Google	Drive	>	New	>	File	Upload	and	upload	your	Word	file.When	the	file	has	uploaded	to	your	Google	Drive,	right	click	and	select	Open	with	>	Google	Docs.Are	you	trying	to	put	a	PDF	into	Google	Docs	instead	of	converting?	If	you	have	important	information	that	you	want	to	share	inside	of	your	Doc,	use	this	method	to	include
PDF	pages	as	images.		Go	to	the	PDF	to	JPG	tool.Upload	the	PDF	from	your	computer,	Google	Drive,	or	Dropbox.Select	Page	to	JPG	to	extract	every	page	of	the	PDF	or	Extract	Images	to	convert	all	images	embedded	in	the	PDF	into	JPG.Click	Convert	to	JPG.Click	Download	JPG	images	to	save	the	files	to	your	local	storage,	upload	them	to	the	cloud
platforms,	or	download	using	a	QR	code	and	link.Open	your	Google	Doc	and	go	to	Insert	>	Image	>	Upload	from	computer.Find	the	JPG	files	you	just	downloaded.Highlight	the	files	you	want	to	add	to	your	Google	Doc	and	select	Open.You	can	also	upload	a	PDF	to	your	Google	Doc	using	Google	Drive.	This	is	a	great	way	to	insert	and	share	the
information	contained	in	PDFs	without	visually	adding	the	pages	to	your	Google	Doc.Imagine	you	have	an	internal	business	document	with	a	large	number	of	PDFs.	Using	this	link-sharing	method	you	can	easily	provide	access	to	Docs	without	having	to	include	hundreds	of	PDF	pages.	Upload	or	save	the	PDF	to	Google	Drive	if	you	haven’t	already.	Find
the	PDF	you	want	to	share	inside	your	Google	Drive.Right-click	the	file	and	select	Get	link.Choose	the	Share	settings	to	decide	who	has	access	to	the	file.	Click	Copy	link.Open	the	Google	Doc	that	requires	the	PDF	link.Paste	the	link	inside	of	your	Doc.Clicking	the	hyperlink	will	open	up	the	PDF	in	a	separate	window.	We	hope	this	guide	has	shown	you
how	easy	it	is	to	convert	and	share	your	documents	between	PDF	and	Google	Docs.	Do	you	work	with	a	lot	of	PDFs?	If	you’re	looking	for	more	PDF	converters	then	iLovePDF	has	the	tools	for	you.	Our	goal	is	to	save	you	time	by	making	your	document	management	as	simple	as	possible.That’s	why	we	offer	several	free	online	PDF	converters	for	Office
and	image	files.	Need	to	convert	a	PDF	to	Word	instead	of	using	Google	Docs?	Use	our	free	PDF	to	Word	tool	for	an	editable	final	document.We	also	offer:PDF	to	Word	/	Word	to	PDF	PDF	to	PowerPoint	/	PowerPoint	to	PDF	PDF	to	Excel	/	Excel	to	PDF	PDF	to	Image	/	Image	to	PDFGo	to	iLovePDF	iLovePDF	takes	security	very	seriously.	Remember
that...	No	matter	which	tool	you	are	using,	we	use	end-to-end	encryption	to	ensure	the	highest	protection	against	theft	or	interception	of	your	documents.	Any	document	uploaded	to	our	system	is	automatically	deleted	after	2	hours	to	prevent	any	unauthorized	third-party	access.	All	our	servers	are	secured	under	European	legislation,	one	of	the	most
restrictive	in	the	world.	Google	Docs	makes	it	easy	to	download	your	documents	in	various	formats,	including	PDF.	You	can	turn	your	documents	into	PDFs	on	your	desktop	as	well	as	on	your	Android	phone.	We'll	show	you	how	to	do	that.	As	of	the	writing	in	May	2022,	Google	Docs	for	iPhone	and	iPad	doesn't	allow	you	to	save	your	documents	in	PDF
format.	Save	a	Google	Doc	as	a	PDF	on	Desktop	Open	the	Google	Doc	in	a	browser.	Click	File	>	Download	>	PDF	Document.	Choose	a	file	location	and	name	and	click	"Save."	On	your	Windows,	Mac,	Linux,	or	Chromebook	computer,	use	the	Google	Docs	website	to	convert	your	documents	to	PDF.	To	start,	open	your	preferred	web	browser	and
launch	Google	Docs.	Sign	in	to	your	account	on	the	site,	then	click	the	document	you	want	to	save	as	a	PDF.	When	the	document	opens,	from	Google	Docs'	menu	bar,	select	File	>	Download	>	PDF	Document.	Your	computer's	standard	"save	as"	window	will	open.	Here,	choose	the	folder	to	save	your	PDF	in,	optionally	enter	a	name	for	the	file,	and
click	"Save."	And	you're	all	set.	Your	chosen	Google	Doc's	PDF	version	is	now	available	in	your	specified	folder.	Did	you	know	you	can	edit	PDFs	with	Google	Docs?	On	your	Android	phone,	use	the	free	Google	Docs	app	to	convert	your	documents	to	PDF	format.	To	begin,	launch	the	Google	Docs	app	on	your	phone.	Then	select	the	document	you	want
to	save	as	a	PDF.	On	the	document	screen,	in	the	top-right	corner,	tap	the	three	dots.	In	the	three-dot	menu,	select	"Share	&	Export."	In	the	"Share	&	Export"	menu,	tap	"Save	As."	You'll	see	a	"Save	As"	menu	listing	the	formats	you	can	download	your	document	in.	Here,	choose	"PDF	Document"	and	tap	"OK."	Your	document's	PDF	preview	will	open.
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files.	Whether	you're	a	student,	professional,	or	simply	someone	who	wants	to	make	the	switch,	this	guide	is	designed	to	help	you	with	guides	and	free	conversion	tools.This	post	will	show	you	how	to:Turn	a	PDF	into	a	Google	Doc.Insert	a	PDF	into	a	Google	Doc	as	an	image.Add	a	PDF	to	your	document	as	a	link.Wondering	how	to	convert	a	PDF	to
Google	Docs?	Here	are	the	simple	steps	and	tools	to	help	you	turn	your	original	file	into	an	editable	Docs	file.Opening	a	PDF	directly	inside	of	Google	Docs	is	useful	if	you	are	trying	to	extract	and	edit	the	text	and	you	aren’t	worried	about	the	formatting.	Your	Doc	will	contain	the	content	of	the	PDF,	but	it	will	be	unorganized	and	images	are	unlikely	to
format	as	you	want	them	to.Go	to	your	Google	Drive	>	New	>	File	Upload.	When	the	PDF	has	uploaded	to	your	Drive,	right	click	and	select	Open	with	>	Google	Docs.Need	to	convert	PDF	to	Google	Docs	without	losing	formatting?	Convert	the	PDF	to	a	Word	document	before	opening	in	Docs.	We	recommend	using	this	method	to	convert	your	files	in	a
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link	inside	of	your	Doc.Clicking	the	hyperlink	will	open	up	the	PDF	in	a	separate	window.	We	hope	this	guide	has	shown	you	how	easy	it	is	to	convert	and	share	your	documents	between	PDF	and	Google	Docs.	Do	you	work	with	a	lot	of	PDFs?	If	you’re	looking	for	more	PDF	converters	then	iLovePDF	has	the	tools	for	you.	Our	goal	is	to	save	you	time	by
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needs	and	preferences.	Pay	attention	to	factors	such	as	compatibility	with	different	devices,	the	level	of	security	you	need,	and	any	limitations	associated	with	free	versions.	With	a	little	planning	and	research,	you'll	find	a	method	that	works	well	for	your	individual	circumstances.	Try	out	the	described	solutions	and	see	if	any	of	them	is	your	go-to
option!	Other	tools	We	recommend	that	first	you	use	the	free	PDF	to	Word	converter.	Keep	reading	to	find	out	why...Are	you	looking	for	an	efficient	and	easy	way	to	convert	your	PDFs	to	Google	Docs?	In	this	blog,	we	walk	you	through	the	steps	to	convert	PDF	files	to	editable	Google	Docs	files.	Whether	you're	a	student,	professional,	or	simply
someone	who	wants	to	make	the	switch,	this	guide	is	designed	to	help	you	with	guides	and	free	conversion	tools.This	post	will	show	you	how	to:Turn	a	PDF	into	a	Google	Doc.Insert	a	PDF	into	a	Google	Doc	as	an	image.Add	a	PDF	to	your	document	as	a	link.Wondering	how	to	convert	a	PDF	to	Google	Docs?	Here	are	the	simple	steps	and	tools	to	help
you	turn	your	original	file	into	an	editable	Docs	file.Opening	a	PDF	directly	inside	of	Google	Docs	is	useful	if	you	are	trying	to	extract	and	edit	the	text	and	you	aren’t	worried	about	the	formatting.	Your	Doc	will	contain	the	content	of	the	PDF,	but	it	will	be	unorganized	and	images	are	unlikely	to	format	as	you	want	them	to.Go	to	your	Google	Drive	>
New	>	File	Upload.	When	the	PDF	has	uploaded	to	your	Drive,	right	click	and	select	Open	with	>	Google	Docs.Need	to	convert	PDF	to	Google	Docs	without	losing	formatting?	Convert	the	PDF	to	a	Word	document	before	opening	in	Docs.	We	recommend	using	this	method	to	convert	your	files	in	a	way	that	keeps	as	much	original	formatting	as
possible.	With	iLovePDF,	you	can	choose	between	normal	conversion	or	OCR.	Without	OCR	the	tool	is	extremely	accurate,	but	if	you	wanted	even	more	accuracy	then	convert	using	OCR.	This	will	scan	the	document	and	its	images	to	create	editable	text	from	the	original	content.Upload	your	file	to	the	free	PDF	to	Word	converter.Choose	between
normal	conversion	or	OCR	and	click	Convert	to	Word	to	download	your	converted	Word	file.Go	to	your	Google	Drive	>	New	>	File	Upload	and	upload	your	Word	file.When	the	file	has	uploaded	to	your	Google	Drive,	right	click	and	select	Open	with	>	Google	Docs.Are	you	trying	to	put	a	PDF	into	Google	Docs	instead	of	converting?	If	you	have
important	information	that	you	want	to	share	inside	of	your	Doc,	use	this	method	to	include	PDF	pages	as	images.		Go	to	the	PDF	to	JPG	tool.Upload	the	PDF	from	your	computer,	Google	Drive,	or	Dropbox.Select	Page	to	JPG	to	extract	every	page	of	the	PDF	or	Extract	Images	to	convert	all	images	embedded	in	the	PDF	into	JPG.Click	Convert	to
JPG.Click	Download	JPG	images	to	save	the	files	to	your	local	storage,	upload	them	to	the	cloud	platforms,	or	download	using	a	QR	code	and	link.Open	your	Google	Doc	and	go	to	Insert	>	Image	>	Upload	from	computer.Find	the	JPG	files	you	just	downloaded.Highlight	the	files	you	want	to	add	to	your	Google	Doc	and	select	Open.You	can	also	upload	a
PDF	to	your	Google	Doc	using	Google	Drive.	This	is	a	great	way	to	insert	and	share	the	information	contained	in	PDFs	without	visually	adding	the	pages	to	your	Google	Doc.Imagine	you	have	an	internal	business	document	with	a	large	number	of	PDFs.	Using	this	link-sharing	method	you	can	easily	provide	access	to	Docs	without	having	to	include
hundreds	of	PDF	pages.	Upload	or	save	the	PDF	to	Google	Drive	if	you	haven’t	already.	Find	the	PDF	you	want	to	share	inside	your	Google	Drive.Right-click	the	file	and	select	Get	link.Choose	the	Share	settings	to	decide	who	has	access	to	the	file.	Click	Copy	link.Open	the	Google	Doc	that	requires	the	PDF	link.Paste	the	link	inside	of	your	Doc.Clicking
the	hyperlink	will	open	up	the	PDF	in	a	separate	window.	We	hope	this	guide	has	shown	you	how	easy	it	is	to	convert	and	share	your	documents	between	PDF	and	Google	Docs.	Do	you	work	with	a	lot	of	PDFs?	If	you’re	looking	for	more	PDF	converters	then	iLovePDF	has	the	tools	for	you.	Our	goal	is	to	save	you	time	by	making	your	document
management	as	simple	as	possible.That’s	why	we	offer	several	free	online	PDF	converters	for	Office	and	image	files.	Need	to	convert	a	PDF	to	Word	instead	of	using	Google	Docs?	Use	our	free	PDF	to	Word	tool	for	an	editable	final	document.We	also	offer:PDF	to	Word	/	Word	to	PDF	PDF	to	PowerPoint	/	PowerPoint	to	PDF	PDF	to	Excel	/	Excel	to	PDF
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